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NOTE
The screen illustrations in this publication are intended to be 
representations, not exact duplicates of the screen layouts generated 
by the software.

PRINTED USER MANUAL
Registered owners of BERNINA® Embroidery Software are permitted 
to create one (1) copy of the BERNINA® Embroidery Software User 
Manual for their personal use. This can be printed with a personal 
printer or through a commercial printing company.

LIMITED WARRANTY
BERNINA International AG warrants for a period of 90 days, 
commencing from the date of delivery of the software to you, that the 
products are free from defects in materials and workmanship. Your 
exclusive remedy for breach of warranty is to return the products 
together with proof of purchase to BERNINA or its authorized dealers 
within the warranty period, and they will be replaced free of charge. 
You are responsible for the cost of shipping and insurance, and bear 
the risk of loss, damage and misplacement of ‘the products’.
The purchaser relies on their own skill and judgement in selecting the 
software for their own use and assumes the entire risk as to the 
results and performance of the software. Subject to warranties and 
conditions imposed by law, BERNINA International AG expressly 
disclaims all other warranties and conditions, whether express or 

implied, including without limitation, warranties and conditions of 
merchantability, fitness for a particular purpose, title and non 
infringement. BERNINA International AG specifically does not warrant 
that the software will meet the purchaser’s requirements or run 
without interruption or error, or appear precisely as described in the 
accompanying documentation.

LIMITATIONS OF LIABILITY
To the maximum extent permitted by applicable law, in no event will 
BERNINA International AG or its developers, officers, employees or 
affiliates be liable to you for any consequential, incidental, or indirect 
damages (including damages for loss of business profits, business 
interruption, loss of business information and the like), whether 
foreseeable, or unforeseeable, arising out of the use of or inability to 
use the software or accompanying security device and cable, and 
accompanying documentation, regardless of the basis of the claim 
and even if BERNINA or an authorized BERNINA representative has 
been advised of the possibility of such damages.
Some states or jurisdictions do not allow the exclusion of incidental, 
consequential or special damages, so the above limitation or 
exclusion may not apply to you.

TERMINATION
Your License to use the BERNINA® Embroidery Software is effective 
as long as you comply with the terms and conditions of the License 
Agreement. This License will terminate automatically without notice 
from BERNINA International AG if you fail to comply with any of the 
terms of the License Agreement.
You may terminate this License at any time by returning the 
BERNINA® Embroidery Software and all copies thereof, the dongle 
security device, cable and all accompanying documentation to 
BERNINA International AG.

CONTACT
If you have any questions, please contact your BERNINA distributor, 
or 
BERNINA International AG
CH-8266 Steckborn/Switzerland
Tel: (41) 52-762 11 11
Fax: (41) 52-762 16 11
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Chapter 1Introduction

Welcome to BERNINA® Embroidery 
Software, the leading embroidery design 
application for home users. This is an 
MS Windows®-based product 
incorporating many of the conventions 
with which most PC users are already 
familiar.
BERNINA Embroidery Software is unique 
in providing seamless integration with 
CorelDRAW® Essentials X6 by the Corel 
Corporation, the most popular 
vector-based drawing package for home 
users. This combination offers a more 
efficient, user-friendly approach to embroidery design by combining the embroidery 
capabilities of BERNINA Embroidery Software with graphical capabilities of CorelDRAW®. It 
also allows users to create not just embroidery, but true, multi-medium designs.

Note  CorelDRAW® Essentials X6 and its sister product, Corel PHOTO-PAINT® Essentials X6 
can also be run as standalone applications. For a full description of the tools, refer to the 
electronic User Guide available via the Windows Start > Programs group. Alternatively, use 
the onscreen help available from the Graphics mode Help menu.
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First-time users
If you are new to BERNINA Embroidery Software, you’ll 
be pleased with its flexible digitizing capabilities, the ease 
with which you can create and edit designs, and how 
simple it is to add or create your own lettering. However, 
before you begin working with the product, please read 
Getting Started.

Update users
BERNINA Embroidery Software is an enhanced version of 
our earlier products. It has many new and expanded 
features. Please read the Release Notes available from the 
Help menu to quickly familiarize yourself with the scope 
of these improvements.

Security device

BERNINA Embroidery 
Software is protected by a 
dongle security device. If 
this is not detected when 
you attempt to launch the 
application, the system 
will not run. Each dongle 
has a serial number and 
identity code so your 

system can be uniquely recognized.
The dongle is the most valuable part of your system and 
should be treated with care. Always store it in a safe 
place when not in use. The dongle is guaranteed against 
defects in material and workmanship, under normal use 
and service when properly installed, for a period of 12 
months from the date of delivery. However, in case of loss 
or theft, you will need to purchase an entire BERNINA 
Embroidery Software replacement system. For this 
reason, you should consider insuring your dongle.

Installing the software

The installation procedure lets you choose:
where the software and sample designs will be 
installed on your PC or network
which components will be installed – e.g. additional 
languages, BERNINA Portfolio, etc.
which documentation files will be installed.

If you are updating your software, do not uninstall the 
current version. Let the installation procedure do this for 
you.

To install the software
Close any other applications open on your computer.USB Dongle
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Disable the Firewall and anti-virus software to ensure 
software and drivers install correctly.
Insert the installation disk into your DVD drive and 
follow the prompts.
You will be prompted to attach your dongle.
If you have an update kit, you will be prompted to 
attach your old dongle as well.

If your PC already contains one or more older versions 
of BERNINA Embroidery Software:

You are prompted to choose a version to merge 
with.
The older version will be merged with the new 
when the PC reboots.

CorelDRAW® Essentials X6 is installed as part of the 
normal installation.
You are given the option to restart with the new 
installation. Shortcut icons are placed on the 

MS Windows® desktop and in the Start > Programs 
group. 
Open BERNINA Embroidery Software.
Any changes that you may have made to your old 
BERNINA Quilter fabric library will now be merged 
with the latest installation. The installation also 
merges any user-defined patterns or motifs.

Resources & support

BERNINA Embroidery Software provides various ways to 
access information about the software and how to use it. 
It also provides links to sources of ready-made 
embroidery designs.

Access BERNINA and 
OESD embroidery 
design studios

Access onscreen 
documentation

Order and install 
upgrades
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Onscreen documentation
Depending on your product level, documentation 
components will include some or all of the following:

Release notes
A set of release notes is included with the software 
installation. These provide detailed information about 
new and improved features as well as direct links to the 
relevant sections of the Reference Manual.

Reference manual
The Reference Manual provides detailed procedures 
covering all features of the BERNINA Embroidery 
Software ‘Embroidery Canvas’. The BERNINA Cross Stitch 
and BERNINA Quilter applications are documented in 
separate supplementary manuals.

Note  For a full description of the CorelDRAW® tools 
available in Artwork Canvas, refer to the electronic User 
Guide available via the Windows Start > Programs 
group. Alternatively, use the onscreen help available from 
the Graphics mode Help menu.

Onscreen help
Onscreen help provides quick access to general 
information on BERNINA Embroidery Software features 

and step-by-step instructions. An <F1> keypress accesses 
context-sensitive help.

Supplementary help
With your BERNINA Embroidery Software installation, 
you will have also received supplementary help accessible 
from ancillary applications:

BERNINA Cross Stitch: This covers the capabilities of 
the special BERNINA Cross Stitch application.
BERNINA Quilter: This covers the capabilities of the 
special BERNINA Quilter application.

Online resources
There are many other sources of ready-made embroidery 
designs which you can purchase and adapt as you wish. 
Your BERNINA Embroidery Software directs you to two 
rich sources – BERNINA and OESD embroidery design 
studios.
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Software upgrades

You may upgrade your BERNINA Embroidery Software 
directly via the Help menu as shown above. When 
referring to your system in correspondence or by 
telephone, you need to quote your Dongle Number. 
You may also need to quote the Serial Number and 
Identity Code. This information is found on the dongle 
itself.

The information can also be found on Security Device 
Options dialog accessed via the Settings menu.
Online upgrades are accessed via the Purchase 
Upgrades on the Internet command in the Help 
menu. The website offers you a choice of upgrade 
relevant to the current level of your dongle. If your 

dongle is at BERNINA EditorPlus level, the website will 
offer an upgrade to BERNINA DesignerPlus. 

Caution  If browser security is set too ‘high’, you may be 
unable to download software updates. If you experience 
this problem, try setting browser security to ‘medium’.
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Chapter 2Getting Started

If you are new to BERNINA Embroidery 
Software or machine embroidery, you 
are probably asking yourself ‘where do 
I start?!’.
It’s safe to say that you will spend many 
hours, both rewarding and at times 
frustrating, learning how to get the 
most out of your BERNINA machine and 
the design software which supports it. 
The two work together hand-in-hand 
and it takes practice and patience to 
master both the creation and 
production of fine embroidery.
The results, however, will speak for 
themselves, making the time you invest 
all the more valuable. With each project 
you complete, you will gain in 
experience and confidence and be 
ready to tackle the next challenge.
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First things first

You don’t need any experience to start with BERNINA 
Embroidery Software. You can simply open a design and 
send it to your machine to ‘stitch out’. And this is the best 
place to start. As you gain experience, you will be able to 
‘read’ designs and identify which are good and which 
may cause problems.

Sample designs & artwork
BERNINA Embroidery Software contains hundreds of 
ready-to-stitch designs, including many attractive 
ornaments, samples and digitizing backdrops. Design 
files (ART files) and images (BMP, JPG, and WMF files) can 
be found in your My Designs - Embroidery 
Software 7 folder. The most valuable thing you can do 
when starting out as a new user, is to spend some time 

exploring these designs and getting to know what’s 
available.

Note  BERNINA Embroidery Software includes its own 
BERNINA Portfolio design management application to 
view and manage your embroidery designs. Alternatively, 
explore design folders using MS Windows® Explorer.

Other sources
There are many other sources of ready-made embroidery 
designs which you can purchase and adapt as you wish. 
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Your BERNINA Embroidery Software directs you to two 
rich sources – BERNINA and OESD embroidery design 
studios.

Clipart
CorelDRAW® Essentials X6 is packaged with a selection 
of clipart which can be accessed via the program group.

Make sure you get familiar with the many clipart 
samples. Many can be adapted for use with embroidery 
design, either as digitizing backdrops or direct 
conversion.

It may be more convenient to take a copy of the entire 
CorelDRAW® Essentials X6 Clipart folder and copy it to 
My Designs - Embroidery Software 7 folder for easy 
reference.

Access BERNINA and 
OESD embroidery 
design studios

Access CorelDRAW® 
clipart folders
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Caution  Included artwork (clipart) and embroidery 
designs are only available for personal use – i.e. they 
cannot be commercially sold in any form.

Rules of good embroidery
Keep the following points in mind when looking at 
embroidery designs, both your own and others:

Stitches are neat, smooth and even
Design looks good – shapes, colors, balance
Shapes are filled with correct fill and outline stitches
Stitches are angled to match shapes
Shapes are stitched correctly – no unwanted gaps
Details are clearly defined
Lettering is clear and easy to read.

The stitchout should also have the following 
characteristics:

The design sews efficiently on the machine
The fabric does not pucker around stitched areas
The design is free of loose ends.

Good embroidery quality starts with good design. You 
then need a good quality machine to stitch it out. But 
even that is not enough if you do not use the correct 
fabric, threads, backings, tension, and so on. Consult 

your machine manual for advice and get as much advice 
from other embroiderers as you can.

Sew a ready-made design

For many embroiderers, it is enough to take an existing 
design and stitch it out. This is certainly where most will 
start. Once you have found a design you like, you will 
want to preview it and see how it sews out. A number of 
steps are involved. We outline the main ones here.

To sew out a design
Open the design in BERNINA Embroidery Software.

Open design
Send design to machine 
directly or via data media 

Preview design
before stitching
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Adjust viewing settings as desired.

Check the fabric type and change as necessary via the 
Design > Fabric Settings menu command.

Press Shift+R to preview the stitchout so you 
understand how the design will sew on the machine.

Send the design to machine directly or via data media 
(usually memory stick).
Check your BERNINA machine documentation for 
steps involved after transferring the design to 
machine.

Modify an entire design

Once you are used to the steps involved in sewing out 
designs – either clipart or ones you have purchased – you 
will soon want to make global design modifications such 
as resizing, or changing thread colors and fabric types. 
These are all relatively simple operations.

To modify an entire design
Open the design you want to use and click to select.

Adjust zoom
factor

Adjust design 
view settings

Stitch count File type

Current fabric

Run simulation

Adjust display 
options

Set stitch range to 
redraw section of 
design Check dimensions

and resize
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Check design dimensions and resize as necessary.
For example, if you are stitching a left chest design, 
maximum size will be approximately 4.25" or 108 
mm square.
Adjust design thread colors as desired.

Check the fabric type and change as necessary via the 
Design > Fabric Settings menu command.

Turn on the hoop. Right-click to select the required 
size.
Use the Design > Background menu command to 
visualize the design on a garment or article.

Send the design to machine directly or via data media 
(usually memory stick).

Create a simple lettering design

Once you are used to sewing out designs and resizing, 
changing colors and fabric types, you will definitely want 
to create your own lettering designs. While it takes 

Cycle through color 
combinations

Select and apply 
current color

Change threads

Turn on hoop
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practice to obtain a good quality lettering stitchout, it is 
as simple as typing letters on-screen to create an 
attractive design in BERNINA Embroidery Software.

To create a simple lettering design
Open a design. Typically you’ll want to add lettering 
to an existing design.
Add embroidery lettering to designs directly 
on-screen.

Right-click the tool to change current settings. It’s a 
simple matter to adjust baselines, formatting, 
spacing settings, and colors.

Try stitching out your lettering design. Study the 
stitch quality. Be aware that different alphabets sew 
out better at different sizes.

Create an embroidery monogram

BERNINA Embroidery Software makes the creation of 
monogramming designs quite simple with the 
‘all-in-one’ Monogramming tool located under the 

Add embroidery
lettering

Adjust lettering 
baseline, 
formatting, etc



BERNINA® Embroidery Software : Quick Start Guide 13

Lettering tool. Optionally include lettering, ornaments, 
and/or up to four concentric borders in your monograms.

Create auto embroidery

If you have graduated this far in your exploration of your 
BERNINA machine and BERNINA Embroidery Software, 
you are doing well. You can already achieve a great deal 
without having to actually do your own design or 
digitizing work. However, if you have graduated this far, 
that is probably exactly what you want to do!
One of the quickest ways to get started is to use the 
automated techniques BERNINA Embroidery Software 
provides. While there are limitations to what can be done 
this way, it nevertheless allows you to prototype design 
ideas relatively simply and may be sufficient for your 
purposes. At least for now!

Vector artwork conversion
Special conversion tools in BERNINA Embroidery 
Software automatically convert vector objects and text to 

Borders stitched 
first – 1, 2, 3, etc

Ornaments 
stitched next

Lettering 
stitched last

Use tabs of 
Monogramming dialog to 
specify settings for 
lettering, ornaments, and 
borders
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embroidery or lettering objects. These can be modified as 
required.

Tip  A good starting point is to use some of the many 
clipart samples packaged with CorelDRAW®. Many of 
these can be adapted for use in embroidery design.

Bitmap artwork conversion
The Magic Wand tool provides everything necessary to 
digitize shapes in bitmap images automatically. An 
extension of this technology, Auto Digitizer recognizes 

shapes in artwork and makes decisions about the most 
suitable stitch types to use.

Tip  Remember to study the sample designs included 
with your BERNINA Embroidery Software installation. Try 
sewing out in order to understand better the techniques 
involved as well as the limitations.

Next steps

If you have reached this point, you have already mastered 
90% of the techniques that most embroiderers need. 

Use this function to convert 
between artwork and 
embroidery

Use Magic Wand and
Auto Digitizer to

recognize shapes in
artwork and convert to

embroidery
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However, coming to grips with the ‘black art’ of manual 
digitizing is the next step in becoming an embroidery 
master. But you don’t have to dive off the deep end. You 
can start with quite simple projects and work your way 
up to more complicated designs with more complicated 
stitch effects. Refer to the Reference Manual or the many 
online resources.

Special embroidery features
Once you have mastered manual digitizing, you are in a 
position to take advantage of the full range of stitch 
types and effects that BERNINA Embroidery Software 

offers. Many of them you will be familiar with, having 
already adapted existing designs for different purposes. 

Some of the many techniques supported by BERNINA 
Embroidery Software include:

Freehand embroidery
Patterned stamps, runs & fills
Craft stitch borders & fills
Appliqué
Cross stitching
Buttonholing
Multi-decoration

1

2

3
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Quilting
Raised embroidery

Refer to the Reference Manual or the many online 
resources.

Happy embroidery!

Do good work with your BERNINA machine and BERNINA 
Embroidery Software. With this equipment you have 
everything you need to create top quality, fully 
professional embroidery. The only thing you lack is the 
capacity to mass produce!
Remember to make good use of the packaged designs 
and clipart. When in doubt, go back to first principles. 
And when you find you want to expand and extend your 
repertoire, study the sample designs carefully to see how 
it’s done. 
All the best. And have fun!
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BERNINA Embroidery Software Quick Reference

BERNINA Embroidery Software integrates with 
CorelDRAW® Essentials X6 into a single application. This 
Quick Reference details commands and tools available in 
the Embroidery Canvas and Hoop Canvas. Not all 
options described here are relevant to all product levels. 
See also Product Feature List in the Reference Manual.

Embroidery Canvas toolbars

The Embroidery Canvas workspace contains the 
toolbars described below. Not all tools are relevant to all 
levels of product.

Canvas toolbar
There are three operating modes in BERNINA Embroidery 
Software accessible via the Canvas toolbar.

Note  For a full description of the 
CorelDRAW® Essentials X6 tools, refer to the electronic 
User Guide available via the Windows Start > Programs 

Artwork 
Canvas

Import, edit or create vector artwork 
as a backdrop for embroidery 
digitizing, manual or automatic.

Embroidery 
Canvas

Digitize and edit embroidery designs. 
Display embroidery as well as 
artwork. View designs realistically in 
3D simulation.

Hoop 
Canvas

View and edit multi-hoopings. If 
embroidery is too large or contains 
multiple designs spaced around an 
article, split into multiple hoopings.

Show 
Embroidery

Show or hide any embroidery 
components.

Convert Embroidery to Artwork: 
Convert selected embroidery objects 
to vector artwork.

Convert Artwork to Embroidery: 
Convert selected vector or bitmap 
artwork to fill or outline stitches.
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group. Alternatively, use the onscreen help available from 
the Graphics mode Help menu.

General toolbar
This toolbar includes tools for opening and outputting 
designs, accessing design properties, and opening and 
closing docker windows.

New Open new blank design.

Open Open an existing design.

Save Save current design.

Print Print active design using current 
settings.

Print Preview View design worksheet. Print 
worksheet from this window.

Write to Card 
/ Machine

Write (save) design to BERNINA 
design card or BERNINA embroidery 
machine.

Cut Same as Edit > Cut.

Copy Same as Edit > Copy.

Paste Same as Edit > Paste.

Undo Same as Edit > Undo.

Redo Same as Edit > Redo.

Insert 
Embroidery Same as File > Insert Embroidery.

Insert 
Artwork Same as File > Insert Artwork.

Application 
Launcher

Access ancillary applications – 
Portfolio, Cross Stitch, and Quilter.

Object 
Properties

Access properties of selected 
embroidery objects or preset with 
nothing selected.

Effects
Apply stitch effects to selected 
embroidery objects or preset with 
nothing selected.

Options Access workspace options such as 
grid, hoop, and scroll settings.



BERNINA® Embroidery Software : Quick Start Guide 19

View toolbar
This toolbar brings together tools for design visualization. 
See also Viewing Designs in the Reference Manual.

Change measurement units within 
software without changing operating 
system settings.

Overview 
Window

Show or hide Overview Window 
docker. Use to zoom and pan 
thumbnail of current design.

Color Film
Show or hide Color Film docker. Use it 
to resequence objects and color blocks 
in the design.

Carving 
Stamp

Show or hide Carving Stamp docker. 
Use preset or custom patterns to 
create a pattern of needle 
penetrations.

Morphing 
Effect

Show or hide Morphing Effect docker. 
Create transformed object outlines and 
stitches.

StumpWork 
Border

Show or hide StumpWork Border 
docker. Use in conjunction with 
StumpWork toolbox.

Show Artistic 
View

Show or hide simulation of stitched 
embroidery.

Dim Artwork Dim backdrops to show stitches more 
clearly when digitizing.

Show 
Stitches Show or hide embroidery stitching.

Show Needle 
Points

Show or hide the needle points in 
embroidery stitching.

Show 
Connectors

Show or hide connecting stitches 
between embroidery objects.

Show Bitmap 
Artwork

Show or hide any bitmap artwork 
included in the design.

Show Vector 
Artwork

Show or hide any vector artwork 
included in the design such as 
CorelDRAW® clipart.

Show 
StumpWork

Show or hide any stumpwork 
sub-designs included in the design.
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Color palette
This toolbar displays a palette of thread colors together 
with tools for selecting, applying, and cycling through 
colors. See also Thread Colors & Charts in the Reference 
Manual.

Stitch toolbar
This toolbar provides a range of basic outline and fill 
stitch types as well as those of a more artistic or 
decorative kind. It also includes stitch effects which can 
be additionally applied. Left-click icons to select stitch 
type. Right-click to access properties. See also Outline & 
Fill Stitches in the Reference Manual.
 

Show 
Appliqué 
Fabric

Show or hide background fabric / color 
of any appliqué objects in the design.

Show Hoop Show or hide hoop. Right-click for 
settings.

Show Grid Show or hide workspace grid. 
Right-click for settings.

Show Rulers 
& Guides

Show or hide workspace rulers and 
guides. Right-click for settings.

Slow Redraw
Simulate embroidery design stitchout 
onscreen in either stitch or artistic 
view.

Color Picker Pick up a color from an existing object 
and make it current.

Apply 
Current 
Color

Apply the currently selected palette 
color to embroidery objects.

Current 
Color

Shows the currently selected palette 
color.

Cycle Used 
Colors

Cycle through combinations of used 
colors. Right- or left-click.

Color Wheel Access Color Wheel to test 
combinations of related colors.

Thread 
Colors

Search for and match threads from 
different charts, and assign for use.

Outlines

Single Outline
Create a single row of stitches along 
a digitized outline – used for borders 
or details.

Triple Outline
Create a thicker outline by repeating 
each stitch three times – use for 
heavier borders or details.
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Backstitch 
Outline

Create traditional backstitch borders 
– old, adaptable stitch type used for 
delicate outlines.

Stemstitch 
Outline

Create traditional stemstitch borders 
or details such as stems and vines.

Satin Outline Create thicker borders or columns of 
even thickness.

Raised Satin 
Outline

Create raised satin borders – can be 
used with trapunto for quilting 
effects.

Blanket Outline Create long, narrow borders with a 
‘comb’ effect.

Blackwork 
Outline

Create ornamental craftstitch 
borders. Name derives from black 
silk thread traditionally used in this 
form of embroidery.

Candlewicking 
Outline

Create ornamental craftstitch 
borders. Specify exact pattern size 
and spacing.

Pattern Run 
Outline

Create ornamental craftstitch 
borders. Choose from pattern library.

Fills

Step Fill Create stitch fills for larger, irregular 
shapes.

Satin Fill Create stitch fills for narrow shapes.

Raised Satin 
Fill

Create raised surfaces – can be 
applied to lettering or used with 
trapunto for quilting effects.

Fancy Fill Create artistic fills while keeping the 
appearance of solid stitching.

Sculptured 
Fancy Fill

Create 3D pattern effects with 
turning fills.

Ripple Fill Create spiral stitching from the 
center of any filled object.

Contour Fill
Create stitching which follows object 
contours, creating a curved, 
light-and-shade effect.

Blackwork Fill

Create fill for blackwork designs. 
Name derives from black silk thread 
traditionally used in this form of 
embroidery.

Candlewicking 
Fill

Create candlewicking fills – 
traditional white-on-white 
embroidery usually done with heavy 
cotton thread on white linen.

Lacework Fill Create a lacey look with open 
trellis-like patterns.
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Transform toolbar
This toolbar contains all the tools you need to select, 
reshape, scale, and mirror embroidery designs in 
Embroidery Canvas mode. See also Arranging & 
Transforming Objects in the Reference Manual.

Pattern Fill Create decorative fill stitching. 
Choose from pattern library.

Cross Stitch Fill
Create open patterned fills with 
crosses generated to suit standard 
grid for entire design. 

Stipple Run Fill Create fills made up of run stitches 
which meander within a border.

Stipple 
Stemstitch Fill

Create heavier stipple run fills with 
stemstitch outlines.

Stipple 
Backstitch Fill

Create heavier stipple run fills with 
backstitch outlines.

Effects

Auto Underlay Strengthen and stabilize objects with 
underlay stitching.

Textured Edge Create rough edges and shading 
effects, or imitate fluffy textures.

Star Fill

Create radial turning stitching with 
available stitch types. Stitches are 
generated from outside to geometric 
center. Center can be shifted.

Wave Fill
Create contoured stitches along a 
digitized guideline – stitching 
maintains uniform density.

Select 
Object

Click to select objects or drag a 
selection marquee to enclose.

Polygon 
Select

Select irregular areas or shapes – click 
reference points to demarcate.

Reshape 
Object

Reshape selected embroidery and 
lettering objects.

Scale Up
Increase/reduce size of selected 
object/s in 20% increments. Stitches 
are automatically recalculated.

Scale Down

Mirror 
Horizontal

Flip selected object/s in horizontal or 
vertical planes.Mirror 

Vertical
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Zoom toolbar
This toolbar includes tools for zooming and panning 
designs. Other zoom presets are available via the View 

menu. See also Zooming & panning in the Reference 
Manual.

Embroidery Canvas toolbox

The Embroidery Canvas workspace contains a 
Toolbox permanently docked on the left of the 
workspace. The Toolbox contains a series of droplists 
containing ‘toolsets’ organized as follows.

Rotate Left
Rotate selected objects in 45° 
increments to right or left.

Rotate Right

Rotate selected objects by specified 
amount – positive or negative – in 
degrees.

Skew selected objects by specified 
amount – positive or negative – in 
degrees.

Enter specific settings for precise 
positioning of selected objects. Use in 
conjunction with Rulers & Guides.

Scale objects or whole designs by a 
precise width or height, or a 
percentage factor. Use Aspect Ratio 
lock to maintain proportions.

Zoom
Left-click to zoom in, right-click to 
zoom out, or drag a ‘zoom box’. 
Shortcut <B> also available.

Zoom Factor: select a preset zoom 
scale from the droplist or key in 
your own zoom scale and press 
Enter.

Pan
Drag to pan across the design at 
high zoom factors. Shortcut <P> 
also available.
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Edit toolset
This toolset contains all tools you need to edit 
embroidery designs in Embroidery Canvas mode.

Auto-Digitize toolset
This toolset contains all tools required for auto-digitizing 
artwork in Embroidery Canvas mode. See also 
Automatic Digitizing in the Reference Manual.

Add Holes Cut holes in filled objects.

Remove 
Holes Remove holes from selected objects.

Add Stitch 
Angles

Add stitch angles to closed objects with 
or without holes. Right-click for 
settings. 

Remove 
Stitch 
Angles

Remove stitch angles from closed 
objects with turning stitches.

Double Run Reinforce outlines, stitching it in the 
opposite direction.

Blackwork 
Run

Automatically sequence selected 
outlines for efficient stitchout.

Color 
Blending

Create blended stitching in selected 
objects.

Fill Holes Fill holes in selected objects with 
current stitch type.

Outline 
Design

Automatically outline selected objects 
with Single, Triple or Satin Line.

Create 
Trapunto 
Outlines

Use in conjunction with raised satin to 
create stitching for a raised ‘quilted’ 
look.

Break Apart
Split monograms, appliqué, lettering, 
and blackwork runs into component 
objects for editing.

Remove 
Overlaps

Remove unwanted stitching underlying 
objects or lettering.

Remove 
Appliqué 
Overlaps

Remove unwanted stitching from 
underlaying appliqué objects. 

Stitch Edit Place the stitch cursor at a selected 
insertion point.

Auto 
Digitizer

Automatically digitize prepared bitmap 
artwork.

Magic Wand Automatically digitize filled areas in 
vector or bitmap artwork.

PhotoSnap Turn grayscale or color photographs 
into embroidery.
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Digitize toolset
This toolset contains all tools required for manually 
digitizing embroidery designs in Embroidery Canvas 
mode. Right-click to access properties. See also Digitizing 
Methods in the Reference Manual.

Open Object Digitize open embroidery objects.

Closed 
Object Digitize closed embroidery objects.

Open 
Freehand

Draw embroidery outlines onscreen in 
the current stitch type.

Closed 
Freehand

Draw closed embroidery objects 
onscreen in the current stitch type – 
outline or fill.

Block Digitize columns with turning stitches.

Ellipse Digitize ellipse or circle embroidery 
objects.

Rectangle
Digitize rectangle or square 
embroidery objects. Press <Ctrl> to 
constrain.

Lettering Create embroidery lettering directly on 
screen. 

Monogram- 
ming

Create personalized monograms using 
a selection of pre-defined styles, 
border shapes and ornaments.

Appliqué Digitize closed-object appliqué with all 
necessary stitching.

Advanced 
Appliqué

Generate open-object appliqué from 
one or more source objects.

Buttonhole Digitize a single buttonhole with all 
necessary stitching.

Buttonholes Digitize a line of buttonholes with all 
necessary stitching.

PunchWork
Digitize PunchWork designs for use 
with the BERNINA Rotary Hook Punch 
tool.

Pattern 
Stamp

Place individual patterns in the design. 
Choose from pattern library.
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Freehand Setting toolbar
When Freehand tools are activated, the Freehand 
Settings toolbar appears.

StumpWork toolset
The StumpWork toolset is available from the Toolbox. 
It contains all the tools necessary to digitize stumpwork 
from scratch or create stumpwork from existing objects. 

See also Stumpwork embroidery in the Reference 
Manual.

Use the Smoothing control to specify, as 
a percentage, how closely the 
smoothed outline follows the original.

Use Show Guide to toggle freehand 
digitizing guide cursor – provides more 
control over ‘freehand’ drawing than the 
default pointer.

Use the Guide Inner Circle Radius control to 
define size of center circle of freehand 
digitizing guide.

Use the Number of Guide Circles control to 
set number of circles in the freehand cursor 
– if the inner circle radius is 2mm, each 
additional guide circle is offset by 2mm.

Create 
StumpWork 
Border

Generate stumpwork border from 
selected objects.

Digitize Open 
StumpWork 
Border

Digitize an open stumpwork border 
using digitized outline and current 
settings.

Digitize Closed 
StumpWork 
Border

Digitize a closed stumpwork border 
using digitized outline and current 
settings.

Cut Closed 
StumpWork 
Border

Cut a closed stumpwork border to 
leave an opening – e.g. for wire 
ends.

Digitize 
Wireline

Create a wireline using a digitized 
outline and current settings.

Create 
Stumpwork 
Sub-design

Create stumpwork sub-design from 
selected objects which include 
embroidery within a stumpwork 
border.

Open 
StumpWork 
Sub-design

View and edit selected stumpwork 
sub-design.

Save 
Stumpwork 
Sub-design As

Save stumpwork sub-design as a 
separate design file.
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Mirror-Merge toolset
This toolset contains all tools required to duplicate and 
transform selected embroidery objects in vertical and 
horizontal planes. See also Mirroring objects in the 
Reference Manual.

Arrange toolset
This toolset contains all tools you need to precisely align, 
distribute and mirror objects in Embroidery Canvas 
mode. See also Arranging & Transforming Objects in the 
Reference Manual.

Mirror-Merge 
Horizontal

Duplicate & mirror horizontally and 
merge overlapping objects 
(optional).

Mirror-Merge 
Vertical

Duplicate & mirror vertically and 
merge overlapping objects 
(optional).

Mirror-Merge 
Horizontal / 
Vertical

Duplicate & mirror selected objects 
around a center point.

Wreath
Duplicate selected objects around 
a central axis. Specify duplicates in 
Mirror-Merge Settings toolbar.

Kaleidoscope

Duplicate & mirror objects around 
a central axis. Specify duplicates in 
Mirror-Merge Settings toolbar. 
This tool only appears when the 
Wreath tool is activated. 

Enter number of wreath points. 
Enter even number to activate 
Kaleidoscope.

Group Combine multiple objects into one 
selectable object grouping.

Ungroup Split object grouping into component 
objects.

Lock Lock selected object/s into position for 
protection.

Unlock All Unlock all locked object/s to remove 
protection.

Align Left Left-align selected objects.

Align Vertical 
Centers

Vertically align centers of selected 
objects.

Align Right Right-align selected objects.

Align Top Align tops of selected objects.
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Color Film toolbar
This toolbar is available in Embroidery Canvas mode.

Align 
Horizontal 
Centers

Horizontally align centers of selected 
objects.

Align Bottom Align bottoms of selected objects.

Align 
Centers Align centers of selected objects.

Space 
Evenly 
Across

Evenly distribute three or more 
selected objects horizontally.

Space 
Evenly Down

Evenly distribute three or more 
selected objects vertically.

Show 
Objects

View individual objects in order of 
stitching sequence. Drag and drop 
object icons to resequence.

Back / 
Forward 1 
Object

Move selection back / forward one 
object in the stitching sequence.

Back / 
Forward 1 
Color

Move selection back / forward one 
color in the stitching sequence.

Move to 
Start / End

Move selection to start / end of 
stitching sequence.

Sequence 
by Selects

Resequence objects in order of 
selection.

Sequence 
by Color

Resequence all blocks of like color. (To 
maintain separate color blocks, use 
Color Film.)
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Multi-Hooping toolbar

This toolbar is available in Hoop Canvas mode. See 
Hooping Designs in the Reference Manual.

Add Hoop Add a new hooping to a multi-hooping 
layout.

Add Hoop 
Right

Place a new hooping to right of 
selected hoop. Allows a 10mm overlap 
between sewing fields.

Add Hoop 
Up

Place a new hooping above selected 
hoop. Allows a 10mm overlap between 
sewing fields.

Add 4 Hoops 
Around Generate 4/8 hoopings around a 

selected hoop’s perimeter. Allow a 
10mm overlap between sewing field. Add 8 Hoops 

Around

Splitting 
Guide

Digitize one or more guides in a 
multi-hoop layout to split objects 
between hoopings.

Delete Hoop Remove selected hoop from hooping 
layout.

Calculate 
Hoopings

Calculate hoopings resulting from 
current layout.
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